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Preface

MATLAB is a tool for technical computing, computation and visualization in an integrated
environment. This document explains the basic concepts in MATLAB.

MATLAB is an abbreviation for MATrix LABoratory, so it is well suited for matrix manipulation and
problem solving related to Linear Algebra.

MATLAB offers lots of additional Toolboxes for different areas such as Control Design, Image
Processing, Digital Signal Processing, etc.

For more information about MATLAB, see my Blog: http://home.hit.no/~hansha
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1Introduction

MATLAB is a tool for technical computing, computation and visualization in an integrated
environment, e.g.,

e Math and computation

e Algorithm development

e Data acquisition

e Modeling, simulation, and prototyping

e Data analysis, exploration, and visualization

e Scientific and engineering graphics

e Application development, including graphical user interface building

MATLAB is developed by The MathWorks. MATLAB is a short-term for MATrix LABoratory. MATLAB is
in use world-wide by researchers and universities.

For more information, see www.mathworks.com

Below we see the MATLAB Environment:

J MATLAB 7.4.0 (R2007a)
Fils Edit Dehug Desktop ‘window Help

O b BB o W B % | curentbiecory: | CrempimatLas 2

Shorteuts (2] How to Add [2] What's Hew

Current Directory wpoa x | [Command Window g e X
ok @ - (@) To get started, select MATLAB Help or Demos from the Help menu, *
Al Files Type Size  Date Modified

This is & Classroom License for instructional use only.
Research and commercial use is prohibited.
¥+ A=[1 2:0 3]

>

& >
Command History oo x
~

reend -

oplot(t, ¥), grid

Fexlabel('Tiwe 0 Yleg t %leg 4')

“~title('Response in the output v(t] after unit step :
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--toolbox

~~help control system

Lhelp linear algehra

5o- 14.10.08 08:17 --%
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< >
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MATLAB has the following windows:

e Command Window
e Command History


http://www.mathworks.com/

2 Introduction

e Workspace
e Current Directory

The Command window is the main window. Use the Command Window to enter variables and to run
functions and M-files scripts (more about m-files later).

Watch the following “Getting Started with MATLAB” video:

http://www.mathworks.com/demos/matlab/getting-started-with-matlab-video-tutorial.html

1.1 Help

MATLAB has a comprehensive Help system.

File Edit WYiew &Go Favorites Desktop Window Help £
Help Navigator Xllamup | S 4
Search for: | | Titlss | Getting Started (Getting Startsd) v/
Example: "plat kools" OF, plot* tools ~
Contents | Ingex | Search Results | Demas Getting Started
~ -
‘|| Getting Started
=-What |3 MATLAB? ' i i
i The MATLAE Syslem MATLAB" is a high-perforrmance language for technical computing. It integrates computation,
X visualization, and programming in an easy-to-use environment where problems and solutions are
IATLAE Documentation . - ! . .
expressed in familiar mathematical notation. This collection includes the following topics:
-Starting and Guitting MATLAB
22252 and Arrays Introduction Describes the components of the MATLAB system
Programming Matrices and Arrays How to use MATLAB to generate matrices and perform
Data Analysis mathematical operations an matrices
Creating Graphical User Interfaces . .
Graphics Howr to plot data, annotate graphs, and work with images
Desktop Tools and Development Environment P ! drapns, d
Examples Brogramrming How to use MATLAB to create scripts and functions, how
Desktop Toals and Development Environment to and manipulate data structures
Mathematic s Data Analysis How to set up a basic data analysis
Diata Analysis
Programming Creating Graphical User Introduces GUIDE, the MATLAE graphical user interface
Graphics Interfaces development environment
B a0 i . _
30 ViISLIEMIEIIDn Desktop Tools and Development — Infarmation about tools and the MATLAB desktop
Creating Graphical User Interfaces Erwitonmment
Functions - By Categary For tutorial informat bout fthe t din th llect th o
e . or tutorial information about any of the topics covered in this collection, see the corresponding
::unztllor:ss Ahlphapbetlcar\t L\gt sections in the MATLAB documentation. For reference information about MATLAB functions, see
=ndle oraphics Froperly Browser the MATLAB Function Reference.
External Interfaces
C and Fortran Functions - By Category Intruductlun
B C and Fortran Functions - Alphabetical List
] Release MNates 1984-2007 The MathWorks, Inc. - Terms of Use - Patents .- Trademarks - Acknowledgments
- Prirtable Documentation (POF) 4
£ &% Emhedded MATLAB v v

You may also type help in your command window

>>help

Or more specific, e.g.,

>>help plot

| advise you to test all the examples in this text in MATLAB in order to get familiar with the program
and its syntax. All examples in the text are outlined in a frame like this:

Tutorial: Introduction to MATLAB
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2Start using MATLAB

This chapter explains the basic concepts in MATLAB.
The topics are as follows:

e The MATLAB Environment
o Command Window
o Command History
o Workspace
o Current Directory
e Variables

2.1 The MATLAB Environment

2.1.1 Command Window

The Command window is the main window. Use the Command Window to enter variables and to run
functions and M-files scripts (more about m-files later).

[Command Window H 0O X

(@ 1o get started, select MATLAB Help or Demas from the Help menu, x

This is & Classroom License for instructional use only.
Research and commercial use is prohibited.
>> A=[1 2:0 3]

1 z
a 3

>> B=ones (5]

B =

bR R e e
[
bR R e e
[
bR R e e

>

You type all your commands after the command Prompt “>>", e.g., defining the following matrix

-1 3

0 3

4



5 Start using MATLAB

The MATLAB syntax is as follows:

>> A = [1 2;0 3]
Or
> A = [1,2;0,3]

If you, for an example, want to find the answer to

a+ b,wherea=4,b =3

>>a=4
>>pb=3
>>a+b

MATLAB then responds:

ans =
7

2.1.2  Command History

Statements you enter in the Command Window are logged in the Command History. From the
Command History, you can view and search for previously run statements, as well as copy and
execute selected statements. You can also create an M-file from selected statements.

----- $-- 30.09.09 08:29 --%
E-%-- 09.10.09 15:34 —-3%

2
o
<)

2.2 Variables

Tutorial: Introduction to MATLAB



6 Start using MATLAB

Variables are defined with the assignment operator, “=". MATLAB is dynamically typed, meaning that
variables can be assigned without declaring their type, and that their type can change. Values can
come from constants, from computation involving values of other variables, or from the output of a
function. For example:

>> x = 17
x =
17
>> x = 'hat'
x =
hat
>> x = [3*%4, pi/2]
x =
12.0000 1.5708
>> y = 3*sin (x)
y =
-1.6097 3.0000

Unlike many other languages, where the semicolon is used to terminate commands, in MATLAB the
semicolon serves to suppress the output of the line that it concludes.

>> a=5

As you see, when you type a semicolon (;) after the command, MATLAB will not respond.

2.2.1  Workspace

The Workspace window list all your variables used as long you have MATLAB opened.

Tutorial: Introduction to MATLAB



7 Start using MATLAB

|Wnrkspace R R s
AEP S| | [ -|stakbse |

Marne - Walue Mlin Max
H A [12:03] 0 3
EH Ax 3 3 3
HE <6¥5 doubles 1 1
- 4 4 4
HH ans <Hx5 doubles 1 1

HH array [13567 9] 1 g
b 3 3 3

You could also use the following command

>>who

This command list all the commands used

or

>>whos

This command lists all the command with the current values, dimensions, etc.

The command clear, will clear all the variables.

>>clear

2.2.2  Current Directory

The Current Directory window list al m files, etc.

Tutorial: Introduction to MATLAB



Start using MATLAB

/ MATLAB 7.4.0 (R2007a)
Edit

Filz Wiew Debug Deskbop  Window Help
o

O & BRo o W E|$ érentDirectory:|C:'|,temp'|,MATL.C\B

Shortcuts [#] How ka Add  [#] What's Mew

@)

-

Current Directory #+ O # X [[00GELRA 0T Command Window

o To get starked, select MATLAE Help or Demos from the Help menu.

All Files « Size | Date Modifi
This is a Classroom License for instructior

Research and commercial use is prohibited.

»r a=5h
a =
. = 5
Lists all mfiles, etc in the
selected directory N
»r clear
=l

2.3 Useful commands

Here are some useful commands:

Command Description
help Help
help x Gives you help on subject “x”
who, whos Get list of variables
clear Clears all variables in the Workspace
clear x Clears the variable x
what List all m files in the Working Folder

Tutorial: Introduction to MATLAB




3Matrices and Vectors

This chapter explains the basic concepts of using vectors and matrices in MATLAB.
Topics:

e Matrices and Vectors syntax
e  Matrices functions

MATLAB is a "Matrix Laboratory", and as such it provides many convenient ways for creating vectors,
matrices, and multi-dimensional arrays. In the MATLAB, a vector refers to a one dimensional (I1xN or
Nx1) matrix, commonly referred to as an array in other programming languages. A matrix generally
refers to a 2-dimensional array, i.e. an mxn array where m and n are greater than or equal to 1.
Arrays with more than two dimensions are referred to as multidimensional arrays.

MATLAB provides a simple way to define simple arrays using the syntax:
“init:increment:terminator”. For instance:

>> array = 1:2:9
array =
13579

defines a variable named array (or assigns a new value to an existing variable with the name array)
which is an array consisting of the values 1, 3, 5, 7, and 9. That is, the array starts at 1 (the init value),
increments with each step from the previous value by 2 (the increment value), and stops once it
reaches (or to avoid exceeding) 9 (the terminator value).

The increment value can actually be left out of this syntax (along with one of the colons), to use a
default value of 1.

>> ari = 1:5
ari =
1 2 3 45

assigns to the variable named ari an array with the values 1, 2, 3, 4, and 5, since the default value of 1
is used as the incrementer.

Note that the indexing is one-based, which is the usual convention for matrices in mathematics. This
is atypical for programming languages, whose arrays more often start with zero.

Matrices can be defined by separating the elements of a row with blank space or comma and using a
semicolon to terminate each row. The list of elements should be surrounded by square brackets: [].
Parentheses: () are used to access elements and subarrays (they are also used to denote a function
argument list).



10 Matrices and Vectors

>> A = [16 3 2 13; 5 10 11 8; 9 6 7 12; 4 15 14 1]

A =

16 3 2 13
510 11 8
9 6 7 12
4 15 14 1
>> A(2,3)
ans =

11

Sets of indices can be specified by expressions such as "2:4", which evaluates to [2, 3, 4]. For
example, a submatrix taken from rows 2 through 4 and columns 3 through 4 can be written as:

>> A(2:4,3:4)
ans =

11 8

7 12

14 1

A square identity matrix of size n can be generated using the function eye, and matrices of any size
with zeros or ones can be generated with the functions zeros and ones, respectively.

>> eye (3)
ans =

100

010

001
>> zeros (2, 3)
ans =

000

000
>> ones (2, 3)
ans =

111
111

Most MATLAB functions can accept matrices and will apply themselves to each element. For
example, mod(2*J,n) will multiply every element in "J" by 2, and then reduce each element modulo
"n". MATLAB does include standard "for" and "while" loops, but using MATLAB's vectorized notation
often produces code that is easier to read and faster to execute. This code, excerpted from the
function magic.m, creates a magic square M for odd values of n (the built-in MATLAB function
meshgrid is used here to generate square matrices | and J containing 1:n).

[J,I] = meshgrid(l:n);
A = mod (I+J-(n+3)/2,n);
B = mod (I+2*J-2,n);
M =n*A + B + 1;

Tutorial: Introduction to MATLAB



11 Matrices and Vectors

3.1 Useful commands

Here are some useful commands:

Command Description
eye (x), eye(x,Vy) Identity matrix of order x
ones (x), ones(x,y) A matrix with only ones
zeros (x), zeros(x,y) A matrix with only zeros
diag([x y z]) Diagonal matrix
size (A) Dimension of matrix A
A’ Inverse of matrix A

Tutorial: Introduction to MATLAB



4Scripts and functions — M
Files

M-files are text files containing MATLAB code. Use the MATLAB Editor or another text editor to
create a file containing the same statements you would type at the MATLAB command line. Save the
file under a name that ends in “.m”.

4.1 Scripts

Create a new m-file from the File > New menu or the New button on the Toolbar.

/ MATLAB 7.4.0 (R2007a)
28 Edit Debug Desktop  ‘Window Help

M-File arrent Directary: | C\templiMATLAE
Open... Chrl+0 Figure
Close Cammand Window ‘atiable .
Import Data. .. Model |
Save Workspace As... GUL o Ta get skarted, select MATLAE He
Sek Path...
Preferences... This is a Classrom
Page Setup... Research and comme:
Prink. .. »r TestLU
Print Selection. ..
1 C:\tempiMATLAE! TestLU.m A=
2 C:\kemp\MATLAB Test LI.m 1 2
3 C:|...\LU Fackarization.m 3 4
4 C:\...\matlabimatfuntlu.m
Exit MATLAR Chrl4Q

The built-in Editor for creating and modifying m-files:

12



13 Scripts and functions — M Files

B Editor, - C:\tempWMATLABATestLU.m =13
File Edit Text Go Cell Tools Debug Deskiop ‘Window Help ERE 4
DEH {2l (S e f| @8 RARE DR | steck[e= |
Z|"Bg il -[to ]+ [ +[u1 ]x |2£:E]0

1- A=[1 2:3 4] O
z— [L,U,P]=luld) =
3

scripk Ln 3 ol 1

Running a m-file in the Command window:

) MATLAB 7.4.0 (R2007a)
Fle Edt Debug Desktop Window Help

O ¢ BB o B B 2| et Diecorl[Cmpirteree ) ]

Shorteuts (2] Hawta Add  [2] What's New
Current Directory = 00 2 x |Command b

Bt @ -

Type atne Vale M
TestLU.m, MHfile This is a Cle ructional use only. Ha [1234] 1
—_— Research and Runyour mfile fromthe fpicea. HL 11003333 1) 0
» Command Window =[] [o110] i
FHu 340 0.6667) 0
List of m_files in your =
working folder
1 2
5 4

0.3333 1.0000
This is the result from the
- mfile
i

+{|Command Window RIS | Workspace 02 x
@ 7o get started, select MATLAE Help or Demos from the Help meru. N hE@EEs w o smck:|

>>

< > < >
4 Start

4.2 Functions

You may create your own functions and save them as a m-file.
Example:

Create a function called “linsolution” which solve Ax =b - x = A~ 1b

Tutorial: Introduction to MATLAB



14 Scripts and functions — M Files

Below we see how the m-file for this function looks like:

B Editor, - C:MempMATLABVinsolution.m E®R
File Edt Text Go Cel Tools Debug Desktop Window Help MEE

N H| s BB =[S e r| 80|80 D@ |5 |
Z ("B B [0 | =11 [x [#£]0

1 lfunction [%] = linsolution(i,B) =
%  Solves the problem Ax=b using x=inv (i) "h

=

%  Created By Hans-Petter Halvorsen

—  x=inv (A} *h;

linsolution ln 1 Col 1

You may define A and b in the Command window and the use the function on order to find x:

>> A=[1 2;3 4];
>> b=[5;6];
>> x = linsolution (A, Db)
% =
-4.0000
4.5000
After the function declaration (function [x] = linsolution (A, b)) inthe m.file, you may

write a description of the function. This is done with the Comment sign “%” before each line.

From the Command window you can then type “help <function name>" in order to read this
information:

>> help linsolution
Solves the problem Ax=b using x=inv (A) *b
Created By Hans-Petter Halvorsen

Tutorial: Introduction to MATLAB



5Flow Control

This chapter explains the basic concepts of flow control in MATLAB.
The topics are as follows:

o [f-else statement

e Switch and case statement
e Forloop

o While loop

5.1 If-else Statement

The if statement evaluates a logical expression and executes a group of statements when the
expression is true. The optional elseif and else keywords provide for the execution of alternate
groups of statements. An end keyword, which matches the if, terminates the last group of
statements. The groups of statements are delineated by the four keywords—no braces or brackets
are involved.

Example:

n=5
if n > 2

M = eye(n)
elseif n < 2

M = zeros (n)
else

M = ones (n)
end

5.2 Switch and Case Statement

The switch statement executes groups of statements based on the value of a variable or expression.
The keywords case and otherwise delineate the groups. Only the first matching case is executed.
There must always be an end to match the switch.

Example:

n=2
switch (n)
case 1

15



16 Flow Control

M = eye(n)
case 2
M = zeros (n)
case 3
M = ones (n)
end

5.3 For loop

The for loop repeats a group of statements a fixed, predetermined number of times. A matching end
delineates the statements.

Example:

m=5
for n = 1:m
r(n) = rank(magic(n)):;
end
r

5.4 While loop

The while loop repeats a group of statements an indefinite number of times under control of a logical
condition. A matching end delineates the statements.

Example:

m=5;

while m > 1
m=m - 1;
zeros (m)

end

Tutorial: Introduction to MATLAB



6Plotting

This chapter explains the basic concepts of creating plots in MATLAB.
Topics:

e Basic Plot commands

Function plot can be used to produce a graph from two vectors x and y. The code:

X 0:p1/100:2*pi;
y = sin(x);
plOt (x, Y)

produces the following figure of the sine function:

ek ]

(i}

nar

-2

-0

8 F

Three-dimensional graphics can be produced using the functions surf, plot3 or mesh.

[X,Y] = meshgrid(-10:0.25:10,-10:0.25:10) ;
f = sinc(sqgrt((X/pi) . "2+ (Y/pi)."2));

mesh (X,Y, f);

axis([-10 10 -10 10 -0.3 1])
xlabel (' {\bfx}")

ylabel (' {\bfy}")

zlabel (' {\bfsinc} ({\bfR})")

hidden off

17



18 Plotting

This code produces the following 3D plot:

Tutorial: Introduction to MATLAB



/Linear Algebra

Linear algebra is a branch of mathematics concerned with the study of matrices, vectors, vector
spaces (also called linear spaces), linear maps (also called linear transformations), and systems of
linear equations.

MATLAB are well suited for Linear Algebra.

/.1 Vectors
Given a vector x

x=|.| €R"

Example:

l

The Transpose of vector x:

xT — [xl Xg oee xn] € Rlxn

>> x!
ans =
1 2 3

The Length of vector x:

llx|| = VxTx = \/xlz + x5+ -+ x2

Orthogonality:

19



20 Linear Algebra

7.2 Matrices

Given a matrix A:

a1 A1m
A= : € R™mM
anl anm
Example:
_I0 1
A_[—z —3]
>> A=[0 1;-2 -3]
A =
0 1
-2 -3
7.2.1 Transpose
The Transpose of matrix A:
Ay ot Am
AT = : : ] € Rmxn
Aim  *° Onm
Example:
r 10 177 _0 -2
ar=5 S = 33
>> A
ans =
0 =2
1 =3

7.2.2 Diagonal

The Diagonal elements of matrix A is the vector

a1

a .
diag(4) =| ;°| € Rp=minGxm)

App

Example:

Tutorial: Introduction to MATLAB



21 Linear Algebra
>> diag(A)
ans =

0

=3

The Diagonal matrix A is given by:

A4 0 0
A= 0 /1_2 € Rnxn
0 o An
Given the Identity matrix /:
1 0 0
- 01 « 0 c pram
0 0 1
Example:
>> eye (3)
ans =
1 0 0
0 1 0
0 0 1

7.2.3  Triangular

Lower Triangular matrix L:

Upper Triangular matrix U:
=l ]
7.2.4  Matrix Multiplication

Given the matrices 4 € R™™ and B € R™P, then
C = AB € R™P

where

Tutorial: Introduction to MATLAB



22 Linear Algebra
n
Cjk = Z a1 by
=1
Example:
>> A=[0 1;-2 -3]
A =
0 1
-2 =3
>> B=[1 0;3 -2]
B =
1 0
3 =2
>> A*B
ans =
3 =2
-11 6
Note!
AB # BA

A(BC) = (AB)C
(A+ B)C = AC + BC

C(A+B)=CA+CB

7.2.5 Matrix Addition

Given the matrices 4 € R™™ and B € R™™ then

C=A+Be€ R™M

Example:

>> A=[0 1;-2 -3]
>> B=[1 0;3 -2]

>> A+B

ans =
1 1
1 =9

7.2.6 Determinant

Given a matrix A € R™", then the Determinant is given:

Tutorial: Introduction to MATLAB
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Given a 2x2 matrix

Then

Example:

det(4) = |A|

_ [an ‘112] c R2x2

a1 Az

det(A) = |A| = ay1a;3; — a0y,

Notice that

and

Example:

det(AB) = det(4) det(B)

det(4T) = det(4)

>> det (A*B)

ans =
-4
>> det (A) *det (B)
ans =
-4
>> det (A'")
ans =
2
>> det (A)
ans =
2

7.2.7 Inverse Matrices

The inverse of a quadratic matrix A € R™" is defined by:
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AAT=A471A=1

For a 2x2 matrix we have:

ai1 Q2
a=| | e R
a1 Az

The inverse A~1 is given by

-1 _ 1 az2 —a12] € R2x2
det(A) =421 a1
Example:
A =
0 1

=2 =3
>> inv (A)
ans =

-1.5000 -0.5000

1.0000 0
Notice that:

AATl=471A=1

- Prove this in MATLAB

7.3 Eigenvalues

Given A € R™™ then the Eigenvalues is defined as:

det(Al —A)=0

Example:
A =

0 1

=2 =3
>> eig (A)
ans =

=1

=2

7.4 Solving Linear Equations
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Given the linear equation

Ax =b
with the solution:
x=A"1h
(Assuming that the inverse of A exists)
Example:
The equations
X1 +2x, =5
3%y +4x, =6
may be written
Ax=b

[ dlal=[C]

where
a=[; il
2=
b=[¢]

The solution is:

>> x=inv (A) *b

-4.0000
4.5000

In MATLAB you could also write “x=A\b”, which should give the same answer. This syntax can also be
used when the inverse of A don’t exists.

Example:
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>> A=[1 2;3 4;7 8]
>> x=1inv (A) *b

??? Error using ==> inv
Matrix must be square.
>> x=A\b
x =

-3.5000

4.1786

7.5 LU factorization

LU factorization of A € R™™ s given by

where

L is a lower triangular matrix

U is a upper triangular matrix

The MATLAB syntaxis [L,U]=1u (a)

Example:

>> A=[1 2;3 4]

>> [L,U]=1u(A)

L =
0.3333 1.0000
1.0000 0

3.0000 4.0000
0 0.6667

Or sometimes LU factorization of A € R™™ s given by

A=LU=LDU

where
D is a diagonal matrix
The MATLAB syntaxis [L, U, P]=1u (A7)

Example:

>> A=[1 2;3 4]

A =
1 2
3 4
>> [L,U,P]=1u(A)
L =
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1.0000 0
0.3333 1.0000
U =
3.0000 4.0000
0 0.6667
P =
0 1
1 0

7.6 The Singular Value Decomposition

(SVD)

The Singular value Decomposition (SVD) of the matrix A € R™™ s given by

where

U is a orthogonal matrix

Vis a orthogonal matrix

S is a diagonal singular matrix

Example:

A=USyT

>> A=[1 2;3 4];
>> [U,S,V] = svd(A)

U =
-0.4046 -0.9145
-0.9145 0.4046

g =
5.4650 0
0 0.3660

VvV =
-0.5760 0.8174
-0.8174 -0.5760

7.7 Commands

Command

Description

[(L,Ul=1u(A)
[L,U,P]=1u(A)

LU Factorization

[U,S,V] = svd(A)

Singular Value Decomposition (SVD )
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8Toolboxes

Toolboxes are specialized collections of M-files built for solving particular classes of problems, e.g.,

e Control System Toolbox

e Signal Processing Toolbox

e Statistics Toolbox

e System identification Toolbox
o etc.

File Edit Yiew Go Favorites Deskiop  Window Help

Help Navigator - S M
Search for: | rem Title: | Toolbox Demos v‘
Example: "plot tools" OR plat* tools
Contents | Indes || Search Results | Demos | Toolbox Demos
- @ Getling Started with Demos
=\ MATLAB

1 Mathematics Toolboxes are specialized collections of k-files (MATLAB language programs) built for solving
(O Graphics particular classes of problems

{23-D Visualization
{22 Programming Our toolboxes represent the efforts of some of the world's top researchers in fislds such as controls,
(23 Desktop Toals and Development Ervironment signal processing, system identification, and others

(3 Creating Graphical User Interfaces Your particular installation might not include all toolboxes, To see which toolboxes your installation

{0 Extemal Interfaces includes, expand the Toolboxes entry in the left pane. From there, select a toolbox to view its demos,
3 Gallery and then select individual demas you want to view and run. You can also find examples in Help. In
(23 Other Demos the Contents pane, select a product and choose Examples to view, run, or copy sample code from
(23 New Features in Yersion 7 the documentation.

To see a list of products that have demos visit www. mathworks. com/products/demos

< Contral Systerm
ﬂ Data Acquisition To get mare information for any of these products, visit www mathworks. com/products, or contact
< Fuzzy Logic Sales

ok Image Processing

< Model Predictive Contral
< Meural Metwork

o Optirnization

<k Signal Processing

i Statistics

< System Identification
#® Yirtual Reality

- Simulink
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9Whats Next?

There are lots of useful resources to dig into if you want to learn more about MATLAB.

Type demo in the Command window in MATLAB

>>demo

In the “Getting Stated with Demos” in the MATLA Help system you get access to tons of Demos in
form of M-files, Videos, etc.

E=E
File Edit View Go Favortes Desktop Window Help !
Help Navigator X | me S
Search for: | ) ~ [g0) | Tite: | Getting Started with Demos -
Example: "plot tools" OR plot* todls -~
Contents | Index | search Results | Gemos | Getting Started with Demos 1
+@ Getting Started with Demos

A MATLAR

= A Tooloxes Choosing a Demo
- 4\ Contral System
ol Data Acquisition Expand the product area in the Isft pane to view a list of its demos. The right pane displays a
- Fuzzy Logic thurmnbnail image and type for each demo. Demo types are
-l Image Processing
%\ Model Predictive Cantrol [% WMfile Demos thattel a step-by-step story, including source code, commentary, and
-l Meural Metwark output. They are published from M-file scripts to HTML using the Editor/Debugger
%\ Optimization cell and file publishing features
& ﬂ Signal Pracessing F1 M-GUI Stand-alone toals for exploring a feature
ol Statistics
-4l System Identification %] Model Black diagrams
&% Virtual Reality .
& % Simulink B Video Movies that highlight key fe_atures in atool. They require Flash Player. Some also

require an Internet connection

Running a Demo

Select a derno from the list and then view information about the demo in the right pane. Use links at
the top to perform these actions

Open... For M-ile and M-GUIl type demos, view the source code in the Editor/Debugger. You
can execute M-ile type demos one section (cell) at a time using the Cell > Evaluate
Cell and Advance menu item.

For Model type demos, open the block diagram in Simulink.

Run...  Execute the demo

K3

Functinn Altarnativa

For more information about MATLAB, see www.mathworks.com

At the MathWorks home page there are lots of Documentation, Examples, Videos, Tips and Tricks,
etc.

Another resource is the MATLAB documentation (may be downloaded as pdf files from
www.mathworks.com), such as:

o MATLAB Desktop Tools and Development Environment
o MATLAB Getting Started Guide

e MATLAB Function Reference

e MATLAB Mathematics
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MATLAB Graphics
Etc.
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Quick Reference

9.1 General

Command

Description

help

Help

help x

Gives you help on subject “x”

who, whos

Get list of variables

clear Clears all variables in the Workspace
clear x Clears the variable x
what List all m files in the Working Folder

9.2 Matrices

Command Description
eye (x), eye(x,Vy) Identity matrix of order x
ones (x), ones(x,Vy) A matrix with only ones
zeros (x), zeros(x,y) A matrix with only zeros
diag([x y z]) Diagonal matrix
size (A) Dimension of matrix A
A’ Inverse of matrix A
9.3 Linear Algebra
Command Description
[L,U]=1lu(A) LU Factorization
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Quick Reference

[L,U,P]=1lu(A)

[U,S,V] = svd(A) Singular Value Decomposition (SVD )

Tutorial: Introduction to MATLAB




L= [

i
Heagskolen i Telemark

Telemark University College
Faculty of Technology
Kjolnes Ring 56
N-3914 Porsgrunn, Norway

www.hit.no

Hans-Petter Halvorsen, M.Sc.
Telemark University College

Department of Electrical Engineering, Information Technology and Cybernetics

Phone: +47 3557 5158

E-mail: hans.p.halvorsen@hit.no

Blog: http://home.hit.no/~hansha/

Room: B-237a



http://www.hit.no/
mailto:hans.p.halvorsen@hit.no
http://home.hit.no/~hansha/

